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STL15 - Steel Design Tool Example

Two Span Girder Design Example

Start the Steel Design Tool program, create a new input file using the File | New command. The program will
switch from the File tab to the Design Input tab.

File | New and File | Save As

HTOWsre Bridge Design: Steel Design Tool

¥ E

E
ol = =
b I

Before proceeding with Design Input return to the File tab and click Save As to rename the file from New Project
to STL15 Design Example.

T Mo Project - AASHTO Wiore Bridge Desige: Sted Design Tool

The new file name will appear in the program title bar and the program will again bring up the the Design Input
with the Project input screen. The Project property will still say New Project and this will be changed in the next
step. The Project property determines the name of the subfolder in the Documents\AASHTOWare\SteelDesign75\

folder where design run output files will be stored. In the bottom left corner of the program window, there is a
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STL15 - Steel Design Tool Example

Validation button that enables input validation. When validation is enabled, the program will mark sections and
input boxes with missing or incorrect information. For the purposes of this example, the Validation will be disabled

during input and will be enabled after all input is entered to verify that there are no validation errors.

Design Input | Project

On the Design Input | Project input screen, enter the data as shown below.

ﬂ 5TL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - m} x
m Design Input Design l
Project Project: STL14 Design Example

Description: |2 Span 4 Girder Bridge
Project Library

Geometry

Deck Designer:

Date: 2/8/2024
Typical Section Loads

LRFD specifications

Beam Perameters Edition: AASHTO LRFD Sth v
Lateral Support ]

oP Limit states: Strength-1 Strength-lI Strength-Ill Strength-V
Member Loads Service-l|

Fatigue- Fatigue-

‘Control Options.

Input Report Design vehicles
Design load: 2t
Permit load: ~

Single lane permit load

Fatigue load: e

Design ADTT: |0

Validation Off Forward |
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Design Input | Project Library | Appurtenance

On the Apputenance tab, select Parapet for Type from the drop down menu and click the Copy from library
button to add a new parapet. Select the Jersey Barrier.

[T STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - u}
DesignInput | Design
Project Appurtenance | haterial | Vehicle
o e 5|
Project Library i
Additional load Additional load
Geometry centroid
X2
. x1 ‘ C X3
Reference |‘ * Roadway
line Surface
Typical Section Loads ! Y1
¥2

Beam Parameters v

Back Fronty Y4
Lateral Support

. r Calculated properties
Member Loads Name Description il e L5 i 2 B i Ad‘f:l::trr‘ji;md Adi;::“al \fr:;aI';:i P
(in) (in) (in} (in} (in} (i} (i} " Net centroid | Total load
(in) (kip/ft) (kef) (in) (idip/ft)

Control Options.

Input Report
[ Copy from library.. ] New | Duplicsts  Delete
Validation | | on < Back Forward [
[l select ltem - O d
MName Description

> Jersey Barrier Standard New Jersey Barrier

QK Cancel
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[ STL14 Design Example.brdx - AASHTOWare Bridge Design: Stecl Design Tool

Design Input

Design

Project Appurtena

€ | Material

Type: Parapet
Project Library Ve

Vehicle

Geametry centroid
X2

Deck X M ‘

Additional load Hﬁddllmnal load

e

Reference * Roadway
line 4" Surface
Typical Section Loads ! i
2
Beam Parameters "
Back Fronty Y4
Lateral Support
£ Calculated properties
Wember Loads Name Description SO L R S S S s e i .
(in) {in} (in) {in) {in) (im) (in) " ey Net centroid ~ Total load
(i) (kip/A (kef) (in) (kip/ft)
Control Options Jersey Barrier | Standard New Jersey Barrier | 120000 20000| 7.0000| 00000 190000 100000  3.0000 01500 78801 0505
Input Report
Copy from library.. New | Duplicate Delete
P
Validation off < Back Forward [
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Design Input | Project Library | Material

On the Material tab, select Concrete for Type from the drop down menu and click the Copy from library button

to copy the Class A (US) concrete material definition from File | Library to the Project Library.

Designnput | Design

Project

Project Library
Geometry

Deck

Typical Section Loads
Beam Parameters
Lateral Support
Member Loads
Control Options

Input Report

Validation

|\ | off

Ol STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool

Appurtenance | Material | vepicle
s o
Compressive T — . Std LRFD Std LRFD - B
Name e strength  Initial compn: mem“:mpa Bl modulie ofe Modulusof | Modulus of | nitial moduli | Initial moduli  Poisson's | Composition
at28days  strength fci i i "y closticiy” | clastity | ofelosticity’| of elasticity ratio of concrete
Fe (lsi) (ks ksi) frsi) (ksi)
[ select item - | X
Name Description
Class A Class A cement concrete
5 | Class A (US) Class A cement concrete
"Class B | Class B cement concrete i
Class B (US) Class B cement concrete
Class € Class C cement concrete
Class € (US) Class C cement concrete
oK Cancel
Copy from library.. |
< Back Forward [
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On the Material tab, select Structural Steel for Type from the drop down menu and click the Copy from library

button to copy the Grade 50W steel material definition from File | Library to the Project Library.

[l STL14 Design Example.brdsx - AASHTOWare Bridge Design: Steel Design Tool - O
Design Input | Design
Project Appurtenance | Material | venicle

b C—
Project Library

Specifiedyield  Specifiedtensile  Modulus Coefficient of
Emry Mame Description | strength (Fy) | strength (Fu) | of elasticity thermal Density
(si) ksi) (ksi) expansion
Deck
Typical Section Loads [ select tem - o X
Name Description

= bren s Grade 600 - >... | AASHTO M270M - over 65 to 100 mm... | *

Grade 690W -... | AASHTO M270M - aver 65 to 100 mm... I
Lateral Support Grade 36 AASHTO M270 Grade 36

Grade 50 AASHTO M270 Grade 50

Member Loads. > Grade 50W AASHTO M270 Grade 50W

‘Grade 70W AASHTO M270 Grade 70W
Grade 100 <=... | AASHTO M270 Grade 100 up te 2.5" t...
Grade 100W <... | AASHTO M270 Grade 100W up to 25"... | ¥

Control Options.

Input Report
I & oK Cancel

Cnpyfmmhhmlyu.l New | Duplicate Delete

Validation | | o < Back Forward [
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On the Material tab, select Reinforcing Steel for Type from the drop down menu and click the Copy from library

button to copy the Grade 60 reinforcing steel material definition from File | Library to the Project Library.

- [m} x

[l STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool

Design Input Design

Validation | | o

Project Appurtenance | Materizl | yehicle
o Type] Reinforcing Steel -
Project Library
Specified yield Modulus Ultimate
Geometry Name Description  strength (Fy) | ofelasticity | strength (Fu) Type
(ksi) (ksi)
Deck
Typical Section Loads (8 select ltem - o X
Name Description
e Grade 300 300 MPa reinforcing steal =
Grade 350 350 MPs reinforcing steel (rail-steel)
(e S Grade 40 40 ksi reinforcing steel
Grade 400 400 MPa reinforcing steel
Rzl Grade 50 50 ksi reinforeing steel (rail-steel)
Grade 500 500 MPs reinforcing steel
Control Opt i )
e ' Grade 80 B0 ksi reinforcing steel |
]
Input Report ox _—
ancel

Capy from library... |

New | Duplicate Delete

< Back

Forward [
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Design Input | Project Library | Vehicle

On the Vehicle tab, copy the HL-93 (US) and LRFD Fatigue Truck (US) vehicle definitions from library.

[0 STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - m}
DesignInput | Design
Project Appurtenance | Material | Ve
L Tendem Lane
Project Library
Reme Description Library type | Notional  Axle Spacing Transverse  Uniform | Concentrat | Concentratec  Add second
load  between axles wheel spacing” lane load load for mon | load for shea  concentrated
Geometry (kip) (") [ii} {kip/ft) (kip) (iip) toad™
HL-93 (Us) AASHTO LRFD Live Load - US unit system 25.0000 400 600 0640
Deck LRFD Fatigue Truc.. | AASHTO LRFD Fatigue Truck - US unit sys...
Typical Section Loads
Beam Parameters
Lateral Support
Copy from library... | New | Duplicate De
Member Loads
Truck:
Axle spacing (ft)
Gontrol Options e o Ale load Gage distance pacing
(kip) #) Minimum | Maximum
Input Report
Totals: 0.00 0.00 000
B Duplicate  Del
Validation | | o | { Back Forward [
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Design Input | Project

Return to the Project tab to define the vehicles for the girder design. Click on the ellipsis button to assign the HL-93
(US) vehicle as the design load and the LRFD Fatigue Truck (US) as the fatigue load. Leave the permit load blank.
Define the design average daily truck traffic as 5000.

[0 STL14 Design Example.brekx - AASHTOWare Bridge Design: Steel Design Tool - O X
ﬂ! Design Input
Project Project: STL14 Design Example
Description: 2 Span 4 Girder Bridge
Project Library
Geometry
Deck Designer:
Date: 2/8/2024

Typical Section Loads

LRFD specifications

Beam Parameters it AASHTO LRFD 9th ~

Latera Support '
pRe Limit states: strength-1 (@@ Strength-1l [@ Strength-m (@ strengtn-v

que-l Fatigue

Member Loads.

Fat

Control Options

Input Report Design vehicles

Design load: HL-83 (US) B

Permit load:
Single lane permit load

Fatigue load: LRFD Fatigue Truck (US)

Design ADTT:

Validation | | o Forward [
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Design Input | Geometry
On the Geometry tab, enter the data as shown below. Depending on your screen resolution, scroll down to enter the

Support information.

[8 5TL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Taol - [u] X
Design Input | Design
Project Superstructure definition type: System definition
Project Library Number of spans: 2 0
Number of beams: 4
Geometry
Girder spacing: 10 ft
Deck
Support skew: 0 Degrees
Typical Section Loads . .
Number of design lanes: ERe
Beam Parameters Spans:
- Lsr;tgih
Lateral Support (fr)
g T
Member Loads e 10000
Control Options
Input Report
Supports:
Support Support type
1 Pinned ~
2 Roller ~
3 Roller ~
End bearing location: Left: 0 in Right: [0 in
Validation I| | Off | \J Back Forward |
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STL15 - Steel Design Tool Example

Design Input | Deck
On the Deck tab, enter the data as shown below. The Splice location gaps table can be used to input regions where

the program should avoid placing shear studs. For this example, leave this table empty.

[0 5TL14 Design Example.brx - AASHTOWare Bridge Design: Steel Design Tool - m} X
Design Input | Design
2]
Project Deck concrete: Class A (US) -
Deck total thickness: 10 in
Project Library
Deck structural thickness: |9 in
C=ty Deck reinforcement
Material: Grade 60 ~
Deck Start dist Length End dista cl B i
art distance eng nd distance . lear cover ar spacing
Support " e " Bar size ) Measured from i
Typical Section Loads > v 80.00 4000 12000| 6 ~ 2.0000 | Top of Str... ™ 40000
Beam Parameters
Lateral Support
Member Loads
Control Options.
Mew  Duplicats  Delete
Input Report
Deck overhang: 3 ft
Haunch depth: 2 in
Edge of haunch to edge of beam: |0 in
Composite deck
Shear connectors
Stud diameter: 0.5 in
shear studs in negative flexure regions
Splice location gaps
Splice location e i
eft gap ight gap
S Left or right Distance 0 " H
Validation | off | < Back Forward |
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Design Input | Typical Section Loads

On the Parapet tab in Typical Section Loads, enter the data as shown below.

vinput | Design

Praject
Project Library

Geometry

Deck

Typical Section Loads
Beam Parameters

Lateral Support

Member Loads

Control Options

Input Report

Valication || | o

[ STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool

o %
N
Stage 2 load distribution: () Uniformily to all girders
By tributary area
By percentage: Erizro %
Wearing surface: Thickness: [2 in Density: [120 pef
Appurtenance loads:
 }
Parapet Median Railing Generic Sidewalk
Back Frant
Edgeofdeck  Distance at Distance at R
Name Stage Load type Measure to  distance measun start end rant face
orientation
from (ft) (ft)
5 JerseyBar. Stagel ¥ DC v | Back v | LeftEdge v 000 000 Left v
JerseyBar.. v | Smgel v | DC | Back | Right Edge 000 000/ Right v
New Duplicate Delete
Disphragm loads:
Girder bay: 1 ~  Copy bay to.
Start distance End distance
- T Number Length ) Load
UPPo! spacing of spaces () (kip)
Left girder Right girder (i) Left girder Right girder H
< Back Forward |

Make sure to scroll to the bottom of the page to define the diaphragm loads. Input the diaphragm loads as shown for

Girder Bay 1 and use the Copy bay to... button to copy the loads to Girder Bay 2 and Girder Bay 3.

Control Options

Input Report

Diaphragm loads:

[ Copy diaphragm to bay(s)
Select the new bayfs): Bay 2

| Bay2

OK Cancel

% Start distance End distance
N ® EriEm Number Length ® Load
PP pacing of spaces ol (kip)
Left girder Right girder () Left girder Right girder
1 v 000 000 000 1 000 000 000 1.000
1 v 000 000 2500 8 20000 20000 20000 1.000
New Duplicate Delete
v
< Back Forward |
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Design Input | Beam Parameters

In the Beam Parameters input section, enter the data as shown below. All of the plate dimensions except for the
web depth can be designed. Providing a larger range of values for any given parameter can help the design tool
converge on a solution. The program will design transverse stiffeners for shear resistance if the Use transverse
stiffeners button is selected. This example does not use this option.

[ STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - ] x
m Design Input ]T 1
a
Section configuration
Praject
Web Min Max Increment
Project Library Depth 60 in 60 in
Thickness 03750 v 07500 8 v
Geometry
Top flange Min Max Increment
Deck Width 12 in 20 in 2 in
Thickness 03000 - 20000 174 v
Typical Section Loads
Bottom flange Min Max Increment
Width 12 20 2
Beam Parameters " " "
Thickness 03000 20000 ~ 14 v

Lateral Support
Uss transverse stiffeners

Member Loads

Control Options

Input Report
Structural steel materials
Web:
‘Grade 50W ~
Top flange
Grade 50W e
Bottom flangs:
°T Grade sow e
Transverse stiffener
‘Grade 50W ~
Bearing stiffener:
- ‘Grade 50W ~
-
Validation | off | o Back Forward [
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Design Input | Lateral Support

In the Lateral Support input section, enter the data as shown below. Top flange lateral support ranges are regions

where the top flange is continuously laterally supported and top flange lateral support locations are discrete points of

lateral support.

Top Flange Lateral Support:

Ranges Locations l

Start
distance

(f)
H1 b 0.00

Length

Support )

200.00

End
distance
(f)
200.00

New Duplicate Delete
Top Flange Lateral Support:
| Ranges Locations ‘
Start End
Support distance Sptaf:]mg Nl:m:;;‘jf LES,_?]th distance
@ " [
r1 ~ 0.00 0.00 1 0.00 0.00
1 b 0.00 25.00 8 200.00 200.00
New Duplicate Delete

Design Input | Member Loads

There are no member loads assigned in this example. Member concentrated loads, member distributed loads and

pedestrian loads could be assigned here.

Last Modified: 3/6/2024
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Design Input | Control Options

Tthe Control Options input section provides options for analysis and design. For this example, leave the options as

is.

[ STL14 Design Example.brdi - AASHTOWare Bridge Design: Steel Design Tool - O X

Design Input

Project Allow moment redistribution
Use appendix AB for flexural resistance

Project Library Allow plastic analysis
Ignore longitudinal reinforcement in negative moment capacity

Geometry Consider deck reinforcement development length

Deck

Typical Section Loads
Beam Parameters.
Lateral Support
Member Loads
Control Options

Input Repart

Validation

I | or | < Back Forward |

At this point, all design data has been defined. Turn Validation on and ensure that there are no validation error

marks displayed next to the input section. Otherwise, go back to these sections and resolve the errors.

Validation || On ﬁ'
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Design Input | Input Report

The Input Report section provides a detailed report of the input data.

[0 5TL14 Design Example brdx - AASHTOWare Bridge Design: Steel Design Tool - o x
B oo oo |
Project Project
Project: STL14 Design Example
Description: 2 Span 4 Girder Bridge
Broject Library

Designer-
Date: 82/88/2824

Geometry LRFD specifications
Edition: AASHTO LRFD 9th
Linit states: Strengtn-I, Strength-II, Strength-III, Strength-V, Service-II, Fatigue-I, Fatigue-IT
Deck Design vehicles

Design load: HL-93 (US)

permit loso
fiypecsiisesnionlcady Single lane permit load: False
Fatigue load: LRFD Fatigue Truck (US)

Beam Parameters Design ADTT: 5800
Lateral Support Project Library

Appurtenance
Member Loads Appurtenance

Parapet
Control Options
Nane Description Distance from | X1 v1 v2 v3 va Additional Median Calc
@n) | ) | @e) | @m) | G | (dR) | (i) 1oad unit load |y oo
Input Report centroid (kiprft) (keF) !
(in)
Jersey Barrier Standard New Jersey 12.0000| 2.0000 7.0000| 0.0000| 19.c000 10.2000 3.0000 ©.1500
Barrier
Material
Concrete
Nane Description Compressive Initial  Coefficient of| Density Density for | Poisson's | Composition Modulus
strength compressive thernal For DL nodulus of ratio of concrete | of rupturcy
« >

Validation | ©On i < Back

File | Print
The Print and Print Preview buttons in the File | Print section apply to the Input Report.

[ STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - O X

ﬂ Design Input | Design I

[] New

) la
Print
= Open print Preview

H save

B save As

& Print

& Recent

fid Liorany

8 Configuration
@ Help

E] License

B Close

B Bt

Design | Design Input
After the input data is entered and reviewed, Design Input run can be performed by clicking on the Design Input

button located on the Design ribbon. Design Input run is based on the input data and produces a design that is
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displayed in the Design Run grid with a brief description and values of the critical design ratios. Select the
checkbox for Shear connector design to design the shear connectors along with the girder in the composite regions.
The beam dropdown is the selection for which girder the program will design and the input for minimum design

ratio defines the target design ratio for which the girder will be designed.

[0 STL14 Design Example brdx - AASHTOWare Bridge Design: Steel Design Tool - o X

Design run View results Input and review  BrDR

Critical

Design | Girder Profile
The Girder Profile tab displays the ranges for steel plates along the web and flanges. After a design input run is
completed, these tables will display the program computed ranges. The user may modify these ranges and reanalyze

the member using the Design Review option.

,,,,,,,

New  Dupicate Delere

Last Modified: 3/6/2024 18



STL15 - Steel Design Tool Example

Design | Stiffeners
The Stiffeners tab displays the results of the stiffener design. This includes transverse stiffeners and bearing
stiffeners. The transverse stiffeners will only be designed when the design input option to Use Transverse

Stiffeners in the Design Input | Beam Parameters window is selected.

[ STL14 Design Examplebrds - AASHTOWare Bridge Design: Steel Design Tool - o x
m Design Input | Design
) Shear connector Beam: 1 . - -
v =
be ¢ 8.5 Minimom = e | % o
Design  Design p; 10 Specification  Tabular  Resut  Engine oo o
mput  review EzrELD checks results  graphs  output
Design run View results Input and review  BrDR
E=zn Description G Pin
run design ratio
111 G1-Design (Volume = 96.8ft"3) v 1040 =
} -

Girder profile ‘ Stiffeners | Shear connectors | Schematics: Profile View

Transverse Stiffeners:

One sided
Transverse Stiffener Width in
Transverse Stiffener Thickness: in
Start Distance ~ Number of Spacing Length End Distance
Bz ") Spaces (in) ) (")
v
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Design | Shear connectors

The Shear connectors tab shows the results of the shear connector design if enabled and if the member has
composite regions.

[ STL14 Design Examplebrdx - AASHTOWare Bridge Design: Steel Design Tool

m Design Input | Design

) Shear connector | Beam: 1 v - — @
be W |8 - B B H B x o

Design  Desian Minimurn Specificetion  Tabuler  Result  Engine

input  review design ratio: - checks SrE cern mamp e =R
Design run View results Input and review  BrOR
Design Description Crtical Pin
run design ratio
111 G1-Design (Volume = 96.8ft43) v 1040 =

) a
Girder profile | Stiffeners| Shear connectors | gchematics: Profile View

Shear Connectors
Stud Height: in
Steel Minimum Tensile Strength: |60.000 kesi
Shear Number per Number of Transverse Spacing S Start Distance Length End Distance
Connector Row Spaces (in) i [ ] ()

» | Shear Stud ™ 4 80 3700 1 s 0.000 40.000 40.000
ShearStud 3 120 5600 1 s 40.000 60.000 100.000
ShearStud 3 120 5600 2 o 0.000 60.000 60.000
Shear Stud 4 80 3700 2 s 60.000 40.000 100.000

Design | Schematics: Profile View

The Schematics: Profile View tab shows a schematic of the girder design.

[
Clrdarpmhlel Stiffer\ersl Shearcar\neclnrs| Schematics: Profile View

BLERQY B® 0% -
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Design | Specification Check

To view the specification check results, click on the Specification checks button from the View results group of the

Design ribbon.

[ STL14 Design Example,brec - AASHTOWare Bridge Design: Steel Design Tool

m Design Input

3 || g Shear comector Beam: 1 . -
Y y 5
v ooy Minimum . = ©
Design  Desin . ) 10 specincation | Tabuiar  Resut  Engine o o
input  review it checks results  graphs  output
Design run View resufts Inputand review  BrDR
D:‘:‘“ Description Crtial Pin
1-na G1- Design (Volume = 96.8ft*3) v 1040 =
[ STL14 Design Example brds - Design Run 1-11.1 x
Specification checks
Artices
Alarticles  ~
Properties APPY | generste  Fommat
Bulet list ~
Specification fifter Report
Girder profile | Stiffeners | Shearc P
4 | Superstructure Component & | Specification reference Pass/Fail -
Qe e B% sm ¥ |y Stage 1 13.2.1 Design Philosophy - Limit State - General General Comp.
R > |Stage 2 +/ 25262 Crteria for Deflection Passed
o 41y5mge3 46.2.7.1 -Sections - Lateral Wind Load Distribution in Multibeam Brid  General Comp.
4gel 5.4.2.6 Modulus of Rupture General Comp.
[ Span 1-0.00 ft. 5.4.2.8 Concrete Density Modification Factor General Comp.
(iSpan 1- 10,00 f. 6.10.1 Estimated Flange Lateral Bending Stress Proportioning General Comp.
. (iSpan 1-12.50 f. 6.10.1.1.1b Stresses for Sections in Positive Flexure General Comp.
Span 1- 2000 f.
pan 1-2000 ft.
- e 6.10.1.10.1 Hybrid Factor, Rh General Comp.
Epan 6:10.1.102 Web Load-Shedding Factor, Rb General Comp.
(Z1Span 1-30.00 f.
an 1 -
5:;" —— +/ 610.1.6 Flange Stress and Member Bending Moments Passed
3 Soan1- 000t +/ 6.10.1.7 Minimum Negative Flexure Concrete Deck Reinforcement  Passed
Zyspan1-5000 6.10.1.9.1 Webs without Longitudinal Stiffeners General Comp.
Z15pan 1 - 6000 . +/ 610.10.1 Shear Connectors - General Passed
iSpan 1-6250 2 + 610.10.1.2 Pitch Passed
|LJSpan 1-70.00 f. 6.10.10.2 Fatigue Resistance General Comp.
2y Span 1-7500 NA 610.11.1.2 Transverse Stiffeners - Projecting Width Not Applicable
2 Span 1-80.00 f. A 610.1.1.3 Transverse Stiffeners - Moment of Inertia Not Applicable
(1Span 1-8750 . +/ 6102 Cross-Section Proportion Limits Passed
(dSpan 1-90.00 / 610422 Flexure Passed
(L4Span 1-10000 ft. 1A 61053 Special Fatigue Requirement for Wbz Not Applicable
(2Span 2- 1000 f. 6.10.6.2.2 Composite Sections in Positive Flexure General Comp.
seeean wnena ¥ - . . - P i

Last Modified: 3/6/2024
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Design | Tabular Results

To view the tabular results, click on the Tabular results button from the View results group of the Design ribbon.

T STL7 Design Exomple brds - AASHTOWsre Bridge Design: Steel Design Tool - o x
Fie D‘;gnllwl!| Design
Shear connector Beam: o
D.:;n De!:gn s 1‘:";‘“:“ 1 Specification Engire Dﬁ‘ ;: =
put  revew outout
Design run Input and review  BrDR
D:l:n Description dzfv;‘r:‘:tn e
. et e = 1 Design Exemplebrds - Design Run 1-1.1 - o x
Tebular results
\;}
Pint
print
Reportiype DeadloadActions  ~  Gage Stagel ©  Deadloadcase Load Casel-Seffload(Stage 1ODC) v
[ Gooerprfie | steners | shearconnec Moment | Shear Acial Reaction | Xdeflection ¥ defiection
Span  Location >
i hQQ ¢ BHW 0% - (kip-ft) (cip) (kip) (kip) (in (i) )
HE 000 000 11 000 81| 00000 00000
e - 1 1000 6258 588 000 o0000| 00669
1 1250 399 533 000 o000 00823
1 2000 1177 365 000 ooo00| 229
1 2500 13316 254 000 00000 01443
1 2500 13316 254 000 oo000|  -01a43
- 1 000 14308 143 000 o0000| 01604
- 1 a7s0| st 025 000 ooo00| 01738
1 4000 14620 080 000 ooo00| 01753
1 so00| 12703 303 000 ooo00| 1672
1 so00| 12703 303 000 ooo00| 01672
1 5000 8557 526 000 00000 01391
1 6250 7172 s&2 000 ooo00| 0129
1 7000 2182 740 000 00000 00076
1 7500 1841 260 000 ooo00| 00749
1 7500 1841 260 000 ooo00| 00749
1 2000 6486 007 000 ooo00) 00528 v

Design | Engine Outputs
To view the contents of the engine output files, click on the Engine outputs button from the View results group of

the Design ribbon, and then double-click on the row corresponding to the required file.
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[0 5714 Design Ecample bordx - AASHTOWYare Bridge Design: Steel Design Tool - o x
jon loput | D<5
Shear connector Beam 1 -
b G @ ——— ] B ¥ X o
Deign Do i Spechcaton  Heuar  Ras s
pa  revew design ratio ats graoe
Design run View resurs gt and review BOR
Design . Critical .
= Description i ot Pin
- G1-Design [Volume = 95.31173) < 1040 ™~
O STL14 Design Example brds - Design Run 1-11.1 E—
=]
ooen
tocer
| Girder profile | Stiffeners | Shear connectors | Schemal o
LA s B 0 - Categary Descriptan File name
— . A Deved wL Suage 2 Deck Development Length Caleulations 52 SpantidDeckReintDevLengthCalcelog
Reinforcement Development Len.. | Stage 3 Dack Reinforcement Development Length Calculations 53 SpanlridDeckReiniDevLengthCalcslog
FE Analysis Stage 33 Infi Lines Finite Element Model and Load Cases. 53 Infi Lines Span.XML
FEAnatysis St9¢ 33 I Lines Hlement Actios,SupportReactions, and Nodaliplacements 531 Lines Span Actions XML
L Ditribution Live Load Distribution Factors Clclaions LRED Dist Factor Cles XT
L Distrbution Liv Load Ditribution Factors Calclations Summary LRED Dis actor Summary TXT
- Speciicaton Checks Stage 3 Spec Check Resuls Stage 3 Spec Check Results XML
Open  Delete
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STL15 - Steel Design Tool Example

Design | Design Review
To illustrate the ability of the program to adjust results of the Design Input run, modify the Top flange table to
define a top flange with a constant 18 inch width along the entire 200 ft length of the girder. Select Design Review

to analyze this modified design.

[ STL14 Design Example.brax - AASHTOWare Bridge Design: Steel Design Tool - O X
m Design Input | Design
.l Shear connector Beam: 1 ~ = — @
el design Minimurm ) = | X ©
Design - 1 Specification  Tabular  Resut  Engine oo o o
input design ratio: checks results  graphs  output
Design run View results Input and review | BrDR
Design Description Critical Pin
run design ratio
14111 G1-Design (Volume = 96.87t"3) v 1040 =
a
New  Duplicate = Delete
Top flange:
Width Thickness S Start distance Length End distance
(in) fin) it ) #) )
> 18000 1.000( 1 v 0000 200000 200000
New  Duplicate | Delete
v
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STL15 - Steel Design Tool Example

After the program finishes performing the design review, it will add another row to the design run grid. The design
review runs are indicated with an R displayed in the Design run column in contrast to an | shown in that column for
design input runs. The results for the Design review runs are displayed and can be reviewed or further modified the
same way as design input runs. Additional design input runs can be performed by modifying the input on the Design
Input tab. Each of the design runs, either input or review, stores a copy of its design input data that is reloaded every

time the design input run is selected in the design run grid.

[ STL14 Design Example.brdx - AASHTOWare Bridge Design: Steel Design Tool - O e
m Design Input | Design
) Shear connector Beam: 1 ~ — — -
v f 57
b § @5 Minimom =| izzi | | o
Design  Design p = 10 Specification  Tabular  Result  Engine S oS,
input  review esign ratie: checks results  graphs  output
Design run View results Input and review | BrDR
Design Description Critical Pin
run design ratio

1111 _G1-Dasian (/olume = 062t*3) | 1040 £ I

1-R1.1 G1 - Design Review v 1049 ® ]
a

New  Duplicate = Delete
Top flange:
Width Thickness S Start distance Length End distance
(i) i) PP (#) (ft) (#)
> 18000 1.000 1 v 0000 200000 200000
New  Duplicate  Delete

v
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